Intermediate Lab
PHYS 3870

CONVEYING INFORMATION
Gathering Information

References:
PHYS 3870 Web Site
USU Library Class Web Site
Introduction to EndNote and EndNote Basic

*EndNote Desktop* is a software program that stores and organizes citations, and enables you to import citations directly into a *Word* document. This extended version is expensive and not necessary.

*Endnote Basic* is a **free** version of this software accessible to USU students, with almost all of the functionality of the main program.

- Create a Citation Library
- Stores and organizes figures and equations
- Can link papers to citations
- Can search bibliographic databases

**Log On**
https://www.myendnoteweb.com/EndNoteWeb.html

**Tutorials**
http://libguides.usu.edu/EndNoteBasic
http://www.endnote.com/training/
Comparing *EndNote Desktop* and *EndNote Basic*

http://endnote.com/product-details/basic

**EndNote basic**

Our free, limited online version of EndNote is perfect when you're new to research and writing.

**From research to publication**

EndNote basic gives you the tools for learning how to do research, cite sources, write term papers, and even match your manuscript to a scientific journal.

- Create an online account to search, save and use your research sources
- Use built-in connections to search the 5 most popular databases
- Save and organize the references you find (up to 50,000)
- Integrate with Microsoft Word to properly cite and format your paper
- Choose from the 7 most popular bibliography formats, including MLA and APA style
- Use manuscript matcher to identify the best journal for your research to be published
Access the USU Library Home Web Page

This page provides an up to date link to the USU library resources tailored to these classes!
http://libguides.usu.edu/content.php?pid=246165

INTRODUCTION TO Modern Physics PHYX 2710
Fall 2004

Intermediate 3870
Fall 2015

The Basics

Part of your work in this class will require you to search the physics literature to identify journal articles that support work you are doing in your labs or other assignments. The "Databases" tab lists good sites for you to use to find journal articles. The "Journals" tab lists information about journals in the Merrill-Cazier Library.

You will be expected to read and cite peer reviewed articles. The authors of these articles submitted their work to be read and critiqued by other experts in the field prior to being accepted for publication in a journal. This is done to insure the published work is reliable and sound.

Sometimes it is not easy to tell if a journal publishes peer-reviewed articles. You can use the table below to help determine if the article is from a peer-reviewed journal. Alternatively, you can always contact your friendly librarian (email the article or citation to the address in this guide) and they can usually tell you very quickly if it is a peer review journal.

One common measure of the reputation and utility of various peer reviewed journals is the impact factor. This is based on the average number of times articles from a given journal are cited by other authors.

<table>
<thead>
<tr>
<th>Scholarly vs. Popular</th>
<th>Scholarly</th>
<th>Popular</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bibliography</td>
<td>yes</td>
<td>usually none present</td>
</tr>
<tr>
<td>Author</td>
<td>noted expert or professional and credentials are provided</td>
<td>journalist, student, or no name provided</td>
</tr>
<tr>
<td>Reading Level</td>
<td>advanced, often with specialized vocabulary or jargon</td>
<td>easy to read</td>
</tr>
<tr>
<td>Purpose</td>
<td>to provide information in a specific field and/or report research findings</td>
<td>provides an overview, opinions, or general information</td>
</tr>
<tr>
<td>Article submission</td>
<td>articles are reviewed by professional peers; editor and editorial staff are experts in the field and may work at a variety of institutions</td>
<td>articles are written by staff of the magazine or newspaper; editor and editorial staff work for the magazine/newspaper</td>
</tr>
<tr>
<td>Article format</td>
<td>structured with sections such as abstract, introduction, methods, results, and discussion</td>
<td>articles do not necessarily follow a set structure or format</td>
</tr>
</tbody>
</table>

Betty Rozum

Email Me

Subjects:
Physics
Using *EndNote Basic* at USU

This page provides an up to date link to the USU library resources for using *EndNote Basic*.

http://libguides.usu.edu/EndNoteBasic

---

**USU Library / LibGuides / Citations: EndNote Basic Home**

**Citations: EndNote Basic:**

**Home**

---

**What can this libguide do for me?**

*EndNote Basic* is a free, web-based program that stores and organizes citations, and enables you to import citations directly into a Word document. It can be used on its own, or with EndNote Desktop, a more expensive application available for purchase.

See the differences between *EndNote* and *EndNote Basic* here.

**Citation Library:** Learn how to build, organize and quickly find citations for your research.

**Using Citation Records:** See how to easily view, search and share your citations with fellow researchers.

**Create a Bibliography:** Explore how you can build a bibliography and easily change the citation style in seconds.

**Cite While You Write:** Insert references, and format citations and bibliographies automatically while you write papers in Word.

**Frequently Asked Questions:** Still having trouble? Check out this tab to find some quick answers.

---

**Create An Account**

**Sign Up For an Account**

1. Log in to *EndNote Basic* at [https://www.myendnoteweb.com](https://www.myendnoteweb.com)
2. Click "Create An Account"
3. Enter the required information and select "I Agree"

---

**Last Updated:** Jul 15, 2015 6:04 PM

**URL:** http://libguides.usu.edu/EndNoteBasic

**Print Page**

---

**Subjects:** Research Tips

---

**Utah State University**

**Intermediate 3870**

**Fall 2015**

**WRITING REPORTS**

**Lecture 6  Slide 5**
Creating an Account for EndNote Basic

(1) Begin on the USU EndNote Basic home page
http://libguides.usu.edu/EndNoteBasic

(2) Create an EndNote account
- Select “create and account”.
- Enter your preferred email and a new password specifically for your EndNote Basic account.

https://www.myendnoteweb.com/EndNoteWeb.html
(3) Set up Google Scholar to work with EndNote Basic.

Video tutorial
https://www.youtube.com/watch?v=35t9RB8G558
Importing Articles from Google Scholar into EndNote Basic

(4) Collect reference files for import into EndNote Basic

- After performing a search on Google Scholar click on the "Import into RefMan" or "Import to EndNote" link to import the reference you want.
- This will download a RefMan file (file type .RIS) or EndNote file (file type .ENW). Collect these files in a temporary directory to upload into EndNote Basic.
- Alternately, when you are presented with a window asking if you want to "Open" or "Save" the file, choose to Save the file.
(5) Follow these steps to import search results into EndNote Basic:

- Log into your EndNote Basic account
- In EndNote Basic, click on Collect/Import Reference in the Import window
- Select the .RIS or .ENW file you downloaded from your temporary by clicking on the Choose File button.
- In the dropdown for Import Option, choose "RefMan (RIS)" or "EndNote Import".
- Select the EndNote Basic reference folder to import To
- Click the Import button and your references will be imported into the specified EndNote Basic folder.
- Repeat this process for each new file.
- Aside: You may have to add “EndNote Import” as an option using the Select Favorites button.
(5) Steps to import search results from alternate sources into *EndNote Basic*:

http://libguides.usu.edu/c.php?g=52841&p=339445

https://www.myendnoteweb.com/EndNoteWeb.html
Managing Your Citations within Your EndNote Basic Library

(6) The downloaded references are now available in the EndNote Basic library:
   - Log into your EndNote Basic account
   - Select My References and the subgroup from My Groups to view the references

https://www.myendnoteweb.com/EndNoteWeb.html
Managing Your Citations within Your EndNote Basic Library

(6) The downloaded references are now available in the EndNote Basic library:
- Detailed instructions for organizing and managing your references are shown at right
- The EndNote Basic Organize tab is shown below.

http://libguides.usu.edu/c.php?g=52841&p=339445

https://www.myendnoteweb.com/EndNoteWeb.html
(8) To use *EndNote Basic* in *Word*:

- Select your choices on the *EndNote Basic* web site for Bibliographic Styles
  - Click on “Select Favorites” next to Bibliographic Styles
  - Highlight your choices and click *Copy to Favorites*
  - These choices will show up in *Word* in the *Style* pulldown list in the *EndNote* tab.
  - When you first open the *EndNote* tab in *Word* you will be prompted to enter the email address and password you associated with *EndNote*. You can save this in *Word* using the *Preferences* selection.

Aside: The bibliographic styles selected here include:
- American Chemical Society
- American Institute of Physics (APS)
- American Journal of Physics
- IEEE Transactions on Plasma Science
- Journal of Geophysical Research
- Physical Review
- Physics Teacher

**Utah State University**

Intermediate 3870
Fall 2015

WRITING REPORTS

Lecture 6 Slide 13
Cite While You Write Plug In for *Word*

(7) To use *EndNote Basic* in Word:
- Download the appropriate plug in using the links in the *Format* tab
- See the *Installation Instructions* for different operating systems below
- Select your choices for *Bibliographic Styles* (see next slide)

Use the *EndNote* plug-in to insert references, and format citations and bibliographies automatically while you write your papers in Word. This plug-in also allows you to save online references to your library in Internet Explorer for Windows.

http://libguides.usu.edu/c.php?g=52841&p=339445

https://www.myendnoteweb.com/EndNoteWeb.html
Cite While You Write in Word

(8) Use the EndNote Basic Cite While You Write plug-in to insert references, and format citations and bibliographies automatically while you write papers in Word.

Inserting cited references in your Word document
1. With your Word document open, place the cursor in the location where you would like the citation to appear

2. Select EndNote Web at the top of the screen (some Word processors will place it under the Tools menu)

3. Click Find Citations (this tool searches your entire EndNote Basic library)

4. Enter a search term in the Find Citations box to find the citation record to insert.

5. Click Search or Find

6. Select the desired reference. More than one record can be selected at any given time - simply hold the Ctrl key while clicking each reference.

7. Click Insert
Skiing is a fabulous sport, especially when one lives in Utah.

Skiing is a fabulous sport, especially (Fox, 2006) when one lives in Utah.

(9) Use the *EndNote Basic* Cite While You Write plug-in to format citations and bibliographies in *Word*.

Inserting cited references in your *Word* document

1. Select *EndNote* at the top of the screen (some *Word* processors will place it under the **Tools** menu)
2. Select the style for citations and the bibliography from the pull down menu.
3. Click on **Update Citations and Bibliography**.

*http://www.endnote.com/training/tutorials/enweb2/English/EndNote_Web-English/EndNote_Web.asp*
An Exercise in Reference Management and Use

Use Google Scholar to find:
- A physics related article by an author with your last name
- An article in American Journal of Physics related to this topic
- An article from within the last 2 years related to this topic
- An article from before you were born related to this topic

Use Google Scholar and EndNote to:
- Use Google Scholar to save citations to these 4 articles in EndNote Basic format
- Write a sort paragraph about the physics topic in Word.
- Use EndNote Basic Cite-While-You-Write to provide citations for your paragraph.
- Use EndNote Basic to create a bibliography for your paragraph using the AIP Style.
- Save your Word file as a PDF file, with a filename LastnameFirstInitial_Endnote.pdf (e.g., DennisonJ_EndNote.pdf).
Spacecraft Charging Tests for Dummies

JR Dennison

Space is big, really big. As Douglas Adams famously said, “Space is big. Really big. You just won't believe how vastly, hugely, mind-bogglingly big it is. I mean, you may think it's a long way down the road to the chemist, but that's just peanuts to space.”¹ Space is also harsh...really harsh.² To understand how this harsh environment affects the materials spacecraft are made out of, tests need to be performed in ground-based test facilities that simulate the space environment.³,⁴ The results of such tests are then used in complex numerical programs that estimate the charging of spacecraft in various space environments.⁵

References